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Chapter 1: New Features 
 

This chapter of the Release Summary for AllFusion ERwin Data Modeler 
(AllFusion ERwin DM) documents new features for r7.2. 

This section contains the following topics: 

SQL Server 2005 Features (see page 7) 
Global Find and Replace (see page 8) 
Name Hardening Wizard (see page 9) 
Collection of Logical Volumetric Information (see page 11) 
New Database Support (see page 11) 
Integration With Microsoft Visual Studio 2005 Team Edition for Database 
Professionals (see page 12) 

 

SQL Server 2005 Features 
Support has been added for data modeling with SQL Server 2005. Editors have 
been added for the following objects: 

 Aggregate 

 Application Role 

 Assembly 
 

 Asymmetric Key 

 Certificate 

 Credential 

 Database 
 

 Database Role 

 File 

 Filegroup (Database) 

 Full-Text Catalog 

 Function 
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Global Find and Replace 
 

 Indexes (Table, Full-Text, XML) 

 Login 

 Partition Function 

 Partition Scheme 

 Physical Files (Databases) 

 Privilege 
 

 Schema 

 Stored Procedure (Model-Level, Table-Level) 

 Symmetric Key 

 Synonym 

 Table 
 

 Triggers (Table, View, Database, Server) 

 User 

 XML Schema Collection 

You can access new features in the property editors from the Database menu 
or from the Model Explorer. Editors for Table Indexes, Full-Text Indexes, and 
XML Indexes are provided on the Model menu. Reverse Engineering and 
Forward Engineering functionality has been updated to support the new 
properties. Support is not provided for any password or encryption key 
information in the model. 

For information on the individual SQL Server property editors, see the online 
help. 

 

Global Find and Replace 
A find and replace feature has been added to the Edit menu and the main 
AllFusion ERwin DM toolbar. Use this feature to globally search the metadata 
of your current model for specific character strings or to globally update data 
model objects. You can search for anything that is exposed in the diagram. For 
example, you can assess the impact of proposed model changes by searching 
for specific text strings. By making global changes you can ensure consistent 
metadata change management in large models in an efficient and effective 
way. 

 

It does not replace Find functionality already implemented elsewhere in the UI 
(i.e. Model Explorer, Action Log, Data Browser, Complete Compare). 
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Name Hardening Wizard 
 

Features include: 

 Match exact case (as typed) or not. 

 Match whole or partial words. 

 Search macro expanded values/macro source, as well as other special 
AllFusion ERwin DM metadata objects. 

 Search using wildcards. 

 Specify search direction (forward or reverse). 

 Easily identify the context for found metadata. 
 

 Provides a visual indication when special metadata objects are referenced 
(e.g. hardened, calculated, read-only, and so on). 

 Override a specified global replacement value on a case-by-case basis. 

 Use standard Microsoft Windows shortcuts for Find (Ctrl+F) and Replace 
(Ctrl+H). 

The new Find and Replace feature is fully integrated with the AllFusion ERwin 
DM user interface to provide access to Undo/Redo functionality, and Advisories 
information. 

 

Name Hardening Wizard 
The Name Hardening Wizard provides a way to set global options to override 
inheritance of names within a model. Using the wizard, you can select the 
object types and object instances for which you need to set logical and 
physical names within the model instead of using the inherited name value. 
This new feature will help you to manage your enterprise-wide naming 
standards. 

 

You access the wizard by selecting Names, Name Hardening from the Tools 
menu. You can set names in this wizard for the following object types and 
object instances: 

 Attributes/Columns 

 Default Values 
 

 Domains 

 Key Groups/Indexes 

 Relationships 

 Entities/Tables 

 Validation Rules 
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Name Hardening Wizard 
 

The wizard also includes the flexibility to specify whether to override name 
inheritance for all model objects, a subset of model objects, or a specific 
model object using the various pages of the wizard. The wizard contains four 
pages: 

Overview—Contains an overview of the Name Hardening Wizard. 

Type Selection—Displays the available object types that you can select for 
which you want to override inheritance such as Attributes, Default Values, and 
Domains. To make object type selection easier, you can right-click anywhere 
on this page to display a context menu where you can select either the Select 
All or Select None option. The options you select on this page are reflected in 
the next page of the wizard, the Object Selection page. 

 

Object Selection—Select the specific model objects or groups of model 
objects (collection nodes) for which you want to override inheritance. When 
you have transitioned to this page from the Type Selection page, all the 
selections that you made on the Type Selection page are listed and selected on 
this page. 

The collection nodes have check boxes that summarize the state of the objects 
under that node (subordinate objects). The check boxes for the collection 
nodes have three states. If none of the subordinate objects are selected, the 
check box for that collection node is not selected. If all of the subordinate 
objects are selected, then the check box for that collection node is selected. If 
some, but not all, of the subordinate objects are selected, then the check box 
for that collection node is selected, and is also shaded. Clicking the collection 
node check box allows toggling of the selection of the entire set of subordinate 
objects. In addition, you can right-click anywhere on this page to display a 
context menu where you can select either the Select All or Select None option. 
Any selections you make to the Selection Sets section on this page are 
immediately reflected in the Selected Objects section. 

 

Action—The Action page reflects the current inheritance settings based on 
what you selected in either the Type Selection page or the Object Selection 
page. The Logical and Physical columns indicate the current status of the 
objects and the Selected Objects column lists their fully qualified names, for 
example, instead of just ‘a,’ an attribute name would be ‘OwnerName.E/1.a.’ 
Also, each object has a check box for selection; select a check box for an 
object if you want to override inheritance, or harden; clear a check box for an 
object for which you want to unharden the name. When you unharden an 
object name, the same name you used in the hardening process remains, 
however, now you have the ability to edit or reset that name (editing or 
resetting of hardened names is not allowed). 
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Collection of Logical Volumetric Information 
 

Collection of Logical Volumetric Information 
Functionality has been added to enable you to enter and maintain table-level 
volumetric information within logical models. In earlier versions of AllFusion 
ERwin DM, this functionality was limited to the physical side of a 
Logical/Physical model. 

 

You can now collect the following information on: 

 Initial number of rows on an entity/table. 

 Rate of growth. 

 Maximum number of rows expected. 
 

This new functionality enables you to have volumetrics information in place 
when you derive a physical model from a logical model. This streamlines the 
transfer of volumetrics information when using design layers to create and 
maintain models. This new feature also includes persistence and 
synchronization of volumetric information between the logical and physical 
sides of a model. 

 

New Database Support 
Support has been added for the following target server databases in AllFusion 
ERwin DM: 

 

Sybase IQ 12.5 and Sybase 15 

Support has been added for Sybase IQ 12.5 and Sybase 15. You can now 
model datatypes, indexes, and physical objects using these target servers. 
Support has also been added in the Reverse Engineer, Forward Engineer, 
Datatype Standards and Complete Compare tools. 

 

MySQL 5.x 

Support has been added for MySQL 5.x. Support has been added for the 
Numeric, Date and time, and String datatypes. Support has also been added in 
the Reverse Engineer, Forward Engineer, Datatype Standards, and Complete 
Compare tools. Because the database connection uses the ODBC driver, no 
password is required when generating the schema or reverse engineering. 
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Integration With Microsoft Visual Studio 2005 Team Edition for Database Professionals 
 

DB2/UDB 8.x/9.x 

AllFusion ERwin Data Modeler has been tested for compatibly with DB2/UDB 
9.x at the level of DB2/UDB 8x. The Target Server dialog has been updated to 
reflect support for version 8.x through 9.x 

Users should be aware of the different default for the Reverse Scan index 
modifier in version 8.x and 9.x. In version 8.x, the Reverse Scan index 
modifier defaults to Allow, while in DB2/UDB 9.x it defaults to Deny. If you 
forward engineer a version 8.x model to a version 9.x database, and later 
reverse engineer that database back to a version 8.x model, the value of 
Reverse Scan will change from Allow to Deny.  

In all other respects, AllFusion ERwin Data Modeler support for DB2/UDB 
version 9.x is compatible with DB2/UDB version 8.x. 

 

Integration With Microsoft Visual Studio 2005 Team Edition for 
Database Professionals 

AllFusion ERwin Data Modeler r7.2 includes an integration with Microsoft Visual 
Studio 2005 Team Edition for Database Professionals, part of the Microsoft 
Visual Studio 2005 Team Suite. 

The AllFusion ERwin DM-Visual Studio integration lets you use your existing 
data models, data modeling skills, and data-modeling tools to streamline the 
data modeling and schema generation process. 

 Use existing AllFusion ERwin DM database designs to jump-start the 
creation of managed objects in Visual Studio. 

 Use the design visualization, task automation and advanced modeling 
features of AllFusion ERwin DM to fine-tune schemas. 

 Reuse data models across the IT environment. 

When you run setup for AllFusion ERwin DM r7.2, the installation script checks 
for a copy of Microsoft Visual Studio 2005 Team Edition for Database 
Professionals. If it detects a copy, the integration components are 
automatically installed, unless you cancel the selection to install the 
components. You can also modify an existing installation of AllFusion ERwin 
DM r7.2 to add the Visual Studio integration. See the installation instructions 
in Chapter 1 of the Integration Guide, provided in PDF format in the \Doc 
folder where AllFusion ERwin DM is installed. 
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Chapter 2: Changes to Existing Features 
 

This chapter documents changes made to existing features for r7.2.  

This section contains the following topics: 

Action Log Filtering (see page 13) 
Tablespace and Database Filtering During Forward Engineer (see page 13) 
PDF Index in Report Template Builder Reports (see page 14) 
Change to Subtype Discriminator UI (see page 14) 
Enhancements to Complete Compare (see page 15) 
Reverse Engineer Enhancement for DB2 Cardinality (see page 17) 
Enhancements to Check Model/Validate SQL Feature (see page 17) 
Macro Enhancements (see page 17) 
Enhancement to the Relationships Editor (see page 18) 
Support Added for Save As 7.1.0 (see page 18) 
AllFusion Data Model Validator Available on Tools Menu (see page 18) 

 

Action Log Filtering 
A metamodel filter has been added to the Action Log toolbar. This filter 
enables you to hide or display selected object and property types. The filter 
does not change the actual transaction log, it only affects the way the 
modeling events are displayed in the Action Log. The Save button saves the 
settings to a file called ActionLog in the install directory. 

Click the metamodel filter icon on the Action Log toolbar to open the Action 
Log Metamodel Filter dialog where you can select or clear items from the list of 
objects and properties. Several high-level categories (such as graphics and 
transforms) are also provided, to limit their display in the Action Log pane. 

 

Tablespace and Database Filtering During Forward Engineer 
When working with a DB2 or Oracle target server database, you can now 
restrict forward engineer schema generation to tables (and other model 
objects) limited to specific Tablespaces and (for DB2/zOS) Databases. This 
enhancement allows you to generate only those model objects required, based 
on FE Options, but bounded by the area(s) of the database that you wish to or 
are permitted to modify. 
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PDF Index in Report Template Builder Reports 
 

PDF Index in Report Template Builder Reports 
The Report Template Builder Properties dialog has been enhanced to include 
an option for generating an index when you choose the PDF output format. On 
the Property Tree tab of the Properties Dialog, select the check box for “Table 
of Contents/Index for PDF” to generate an index in your PDF output. The index 
is based on the model object names. 

 

The index in the PDF output file includes the following features: 

 Generates an alphabetic index grouped into sections based on the first 
index term. 

 Creates a hyperlink on all page referenced for the index term so that you 
can quickly navigate to the location in your model. 

 Is based on and includes the names of all model objects. 
 

Change to Subtype Discriminator UI 
When you right-click a subtype relationship, an editor appears. In earlier 
versions of AllFusion ERwin DM, this editor was called “Subtype Relationships”. 
In those versions, a category discriminator could only be an attribute that 
existed in the supertype (or generic) entity. This rule limited your ability to 
select from the pool of valid IDEF1x discriminators. 

 

In r7.2 this editor has been renamed “Subtype Properties” and has been 
redesigned to provide expanded support for IDEF modeling features. In the 
new dialog: 

 The discriminator can be a single attribute or a combination of multiple 
attributes. 

 The discriminator can be from one or more candidate entities, where a 
candidate entity is defined as the generic entity, an ancestor entity, or a 
child entity. 

 

 If the discriminator is from a candidate entity that is not the generic 
entity, and the categorization type is “complete,” then the cardinality of all 
relationships between the generic entity and the candidate entity will be 
1:1. 

 The discriminator cannot already be the discriminator in another category 
relationship emerging from a candidate entity. 

 The discriminator may be part of the primary/alternate key(s) of the 
generic entity, but cannot be the entire key itself. 
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Enhancements to Complete Compare 
 

Additional features have been added so you can toggle the display of 
discriminators on or off, either globally or within a subject area. Right-click in 
the workplace and choose Relationship Display, then select Subtype 
Discriminator on the submenu. You can also set the display from the 
Relationship Display option on the Format menu, or the Stored Displays 
Settings option on the Format menu. 

When you turn off the display of the subtype discriminators, you can still 
display a tool tip with the discriminator information when you move the cursor 
over the relationship symbol. 

 

Enhancements to Complete Compare 

Enhancements to the Resolve Differences Dialog 

The Resolve Differences dialog in the Complete Compare wizard has been 
enhanced to allow you to create a snapshot of known differences, which you 
can then use as a filter to hide those differences when comparing models. 

 

Toolbar icons have been added to allow you to quickly mark a row as a known 
and acceptable difference, then save those items as a snapshot. You can later 
load your saved snapshot to bring in the criteria for the known differences to 
your compare session. While working in the Resolve Differences dialog, you 
can also toggle the display of known differences on or off. 

Snapshots can also be saved, loaded, and managed independently for reuse at 
a later date. To open the Manage Model Snapshots dialog, click Complete 
Compare on the Tools menu, then select Snapshots. 
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Enhancements to Complete Compare 
 

The toolbars on the Resolve Differences dialog have been redesigned. The new 
ordering groups functionality into areas that better reflect typical compare 
actions. The new toolbars include: 

Standard Toolbar

Perform a specific action on a selected item in the list of differences. For 
example, you can copy an item from one model to the other, or match or 
unmatch items.  

Impact Analysis Toolbar

Invoke additional functionality as you resolve differences. You can view the 
Impact Analysis dialog and the Message Log. In some cases, you can 
generate an alter script for either the left or right model using the Left 
Alter Script or Right Alter Script buttons. 

Known Differences Toolbar 

Mark known differences and work with snapshots.  

Standard Filters Toolbar

Filter the display of differences in order to refine the compare process.  

Navigation Toolbar 

Navigate the list of known differences, search for an item, and expand or 
collapse the trees.

The online help includes detailed information about each of the new toolbars. 
 

New Advanced Option - Include Only Generated Objects 

A check box labeled "Include Only Generated Objects" has been added to the 
Advanced pane of the Complete Compare wizard. Each editor for a physical 
object includes a 'Generate' check box, which is selected by default. The 
'Generate' check box indicates that you want to generate SQL for this object 
during forward engineering. When working with a database-level compare in 
Complete Compare, the 'Include Only Generated Objects' check box is selected 
by default on the Advanced pane. If you clear the 'Include Only Generated 
Objects' check box, the compare session will also include those objects for 
which you cleared the 'Generate' check box in the property editor. 
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Reverse Engineer Enhancement for DB2 Cardinality 
 

Reverse Engineer Enhancement for DB2 Cardinality 
An enhancement has been added for DB2 z/OS version 7 and higher. When 
reverse engineering, if a unique index is found to exist on a child table 
containing the same columns as an FK index, the related relationship is 
automatically assigned the “Zero or One to One” cardinality. This enhancement 
has been added to ensure that cardinality is correctly identified based on 
information provided in the DB2 database catalog. 

 

Enhancements to Check Model/Validate SQL Feature 
You can create a Model Validation report before you forward engineer your 
model. The validation process checks for corrupt objects and reports other 
errors associated with correct forward engineering. Enhancements have been 
added to expand the scope of model validation. In a physical model, from the 
Tools menu choose Forward Engineering, then Check Model. You can also click 
the Check Model icon on the Database toolbar. 

Click F1 in the Model Check dialog for detailed information about the objects 
and properties that are validated during a model check. 

 

Macro Enhancements 
A new macro, %ValidationLogicalName, has been created as a Constraint 
macro in the Macro Toolbox. Use %ValidationLogicalName to return the logical 
name of a validation rule. 

This macro has been added to resolve a potential problem when "self-
referencing" macros are entered in the Name Mapping tab of the Model 
Naming Options dialog. Each of the following is an example of a "self-
referencing" macro definition: 

 Using %TableName when mapping Entity to Table 

 Using %IndexName when mapping Key Group to Index 

 Using %ColumnName when mapping Attribute to Column 

 Using %ValidationName for the Validation Rule 

A warning message now appears when you enter "self-referencing" macros, 
advising you to correct the entry. 
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Enhancement to the Relationships Editor 
 

Enhancement to the Relationships Editor 
An enhancement has been made to the Relationships Editor on the physical 
side in a Logical/Physical model. You can now enter a blank foreign key 
constraint name on the General tab of the Relationships editor. 

A reset button has been added next to the Foreign Key Constraint Name label 
in the editor. When you click reset, the text in the constraint name field is 
inherited from the logical name. If you delete the text from the Foreign Key 
Constraint Name field, the constraint name is set to an empty string. 

 

Support Added for Save As 7.1.0 
Support has been added to allow you to save a r7.2 model in r7.1 format. This 
option has been added to the "Save as type" list in the Save As dialog you can 
open from the File menu. 

 

AllFusion Data Model Validator Available on Tools Menu 
If you have installed AllFusion Data Model Validator, you can now start this 
program from the Tools menu in AllFusion ERwin DM. This feature enables you 
to quickly access the database validation features provided with AllFusion Data 
Model Validator, at the same time you are working with data models in 
AllFusion ERwin DM. 
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